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OpenRoads Designer & MicroStation CONNECT Edition
Introduction

GOAL

The CONNECT Edition products will be replacing all other Bentley Software products. New projects in 2022 will be surveyed using
new survey codes and processed using OpenRoads Designer (ORD) survey. Projects started with SS4 shall be reviewed and if
feasible will be upgraded to ORD and MicroStation CONNECT.

Differences

CONNECT is quite a change from SS4 and has prompted a lot of rethinking and development of resources to work in the new
platform. CONNECT is set up to use annotation scale. Annotation scale will be turned on in all drawings which allows the scale
to be changed easily updating the size of all Text, LineStyle scales as well as cell sizes.

Many items will be using By-Level settings and all level names are being updated in CONNECT. Levels will exist in the DGBLIB
files and all levels will be seen from all drawings. Level filters will help to reduce the number of levels shown in each drawing.

Previously the DOT only used Design models for project work. Many of our consultants have used sheet models and the new
CONNECT Edition work flows will use Design models for various project details drawn at 1:1 scale but they will be referenced and
annotated into Drawing models which will be further referenced into the Sheet models at 1°=50’ or 1"=20’ scale. The Sheet models
will be used in the Plan Sheet index for sheet numbering and for plotting using Print Organizer.
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Fonts and Text Styles
There are going to be new True Type fonts used in drawings where there used to be one with line weights

indicating proposed and

existing text. The fonts are Engineering Vert Mono for existing information and Engineering Vert Mono Bold for proposed.
Some drawings may use Engineering Vert Bold or Engineering Bold for titles. The fonts are True Type fonts and become

thicker as they get larger. No font has the Bar bend symbols used by bridge design yet though it is planned to create them in the
future. These fonts have been used to create Text Styles which are used within both ORD and | B PlaceTet  — X

MicroStation.

Text on drawings will use the text styles which are set up to use annotation scale. When placing

a piece of text, you may notice the size is very small, ensure that the Annotation scale lock is on

=X A e

........................

when placing text. Using text style 009 _Eng Vert Mo Bold_xx for proposed text approximates the | iActive Angle:

text size of 5 for a 50 scale drawing previously used. The .009 Height and Width is multiplied by

........................

[] View Independent

the annotation scale equating to 0.009 x 1”=50" x 12"/’ = 5.4. Existing text will use the 008_Eng
Vert Mo_xx text style which is 0.008 x 600 = 4.8 high and is narrower in thickness.

Cells

All cells are being updated to Annotation scale cells. Cells in SS4 were sized to be placed .

at a scale of 1 on a 50 scale drawing. They are all being scaled down to 1/600 to make Active Angle:
them usable with annotation scale which will multiply their scale by the scale chosen. X Scale:

Many other cells will not be scaled down as they are placed directly on 1:1 borders used

in/on the sheet models. Y Scale:

4% Place Active Cell — X

2Bl ower Pole - EPPWHR

00°00'00.0" =
1.000000 [

&
1.000000 L

[] Place as Shared Cell
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LineStyles and Scale

All linestyles have been recreated so their size will work with Annotation Scale. Linestyles
in SS4 were created to be at a scale of 1 when used on 50 scale plans. In CE most
linestyles have been scaled down by 1/600 so they will work with the annotation scale.
Drawings created in CE will have their model’s line scale set to Annotation Scale to take
advantage of this. SS4 files have the Line Style Scale set to Global Line Style Scale = 1.
The New Line styles begin with an * in their name to differentiate them from the SS4 line
styles. There are several line styles that are created at actual scale such as the guard rail
linestyles for post spacing and RR track line style for the rail spacing.

General
Is Active True
[EEEN Defauit
Description Master Model
Ref Logical
Type Design
Design Dimension 2D
Is Markup False
Annotation Scale 1"=50"
Design Scale 600.0000
Paper Scale 1.0000
Propagate Annotation Scale On
Line Style Scale Annotation Scale

Update Fields Automaticzlly True
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Summary

MicroStation Connect (MSC), just like MicroStation in the past, primarily deals with single model 2D dgn files for content. With the
coming of CONNECT it will or can now have drawing models, and any plan that wants to make it into the plan set will also now
have a sheet model. Sheet models can be created in a separate dgn and reference the content of the 2d design models in the
regular dgn files. Sheet models are referenced into the Sheet Index, which uses Print Organizer to print the sheets. Connect uses
Annotation scale for line, text and cell scaling. The same “Default 2D” model can be referenced into two different sheet models of
different scales and be “the correct size” in both. When working in MSC and referencing “civil” or OpenRoads Designer (ORD)
two-model dgn files you need to understand ORD concepts so you can make a decision on what to reference.

ORD works with a two-model seed file. It has a 2D and a 3D model within the dgn. The 3D model’s information is generally
controlled by the software. The 3D model is attached “civilly” to the 2D model with live nesting. When you attach another ORD
Civil drawing to an ORD drawing when you are in ORD you attach the Default model to the Default model. The reference file’s
Default 3D model will automatically be attached to the Default 3D model of the file your in. Using level display you can turn levels
on/off in the Referenced 2D Default model or in its referenced Default 3D model.

Survey information is solely 3D information created using the Survey tools. Data can also be imported from MX to create the 3D
survey features and terrain model. So if you are referencing any “Terrain.dgn” you will be looking at the 3D model of that. A terrain
dgn can be a single 3D model dgn file, but generally a Terrain dgn is an ORD two-model dgn and the Terrain model itself is in the
3D model. In ORD, the Default model of the working drawing should have a reference attachment to the Default model of the
Terrain dgn. The Default 3D model will automatically be attached so you can see the 3D features and 3D terrain model. If
referencing in MSC you should reference the Default 3D model.

Geometry (alignment) information is stored in a geometry.dgn. A 2D horizontal alignment is created using the horizontal geometry
“civil” tools. Then, the vertical geometry tools are used to create a profile. The profile is created in a civil profile view. When the
profile is set to be Active, the alignment feature becomes “3D” as it now has horizontal and vertical components. Only the portion
of the alignment that has the active profile will show up in the Default 3D model. If the beginning and/or end of the alignment do
not have a profile designed, that portion will not be displayed in the Default 3D model. In MSC you should reference the Default
model (2D) of the geometry dgn file.

Corridors are created in a corridor dgn file from the geometry. The template is added and slopes interface with the active terrain
model, typically the existing terrain model. A corridor is created and a template is selected that is basically placed every 5 feet
along the Alignment feature’s 3D geometry. It can be placed from the start of the alignment to the end. The corridor will only be
created where there is 3D geometry... meaning where there is an active profile. A corridor also contains other controls affecting
the road.... Like parametric constraints... which modify the base corridor values like the slopes. There can also be Point Controls
which can, for example, tell a toe of slope to move to the Row line. Corridors can also be clipped... where a drive or side road
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intersects it.... or more commonly where there is a bridge. In this instance the road corridor and bridge corridor are clipped out at
the skew angle of the abutments and/or where the wingwalls are. When a corridor is clipped, only the 3D information gets clipped.
The 2D corridor’s features control how the 3D gets created but, because they are the base of the 3D, they do not get clipped.
When a corridor is referenced to a drawing in MSC, the reference should be to the corridor’s Default 3D model.

Other drawings that use the Drainage and Utilities tool set should have their Default model attached to MSC plan drawings. An
ORD Drainage and Utility drawing has 2D annotation scale cells and lines that represent the features for plan sheets. Their 3D
counterparts are the Actual 3D models representing those features for the cross sections.

Cut sheets are now “started” or created in ORD on projects that have civil information. When the Default model of files are
referenced to the Default model of the file being worked on, the Default 3D models are also attached. This provides the opportunity
to manipulate the display of levels in both the 2D and 3D models of attached reference files to create the desired display for the
cut sheet. After creation, the cut sheet’s Default model’s levels can be manipulated using MSC. The Default model acts as the
master model in which all saved display changes are reflected in all the cutsheets

When the cut sheet process is done in ORD, it creates many new models in the cutsheet dgn. Drawing models and sheet models
are created for each Named Boundary. Named boundaries are basically the closed clipping shapes used to define the area to be
included in each cut sheet and can be modified by inserting\editing vertices. Each set of cut sheets should ... .
be in its own dgn file. ——

Terrains & Contours " g
The display of Civil Terrain models can be controlled within MSC. If you are in a 2D MSC dgn file, reference - on
the Terrain dgn file’s Default 3D model to the current drawing’s Default model. If only the outline is displayed, 2™ :

select it. Then, in the Properties box (Element Information), scroll down to the Reference tab. Toggle the
Override Symbology option to Yes. The Calculated Features Display and Source Feature Display can now
be manipulated to turn the contours, triangles, flow arrows and other things on or off.

Heference -~
wpien  Tomen'\NH_Desgn Cort

The Override can also have a Template applied which changes the displayed information based on the “Civil” =255 @

Terrain Feature definitions. For example, instead of just turning on existing contours, the NH_Design_Contours template can be
selected. That feature definition will be applied to display the contours in the “proposed” levels, colors and weights rather than the
existing.

For contours to be displayed in drawings, it is suggested that the process in Section P-6-6: Creating MS Contours from a Terrain
Model, be followed to create actual contour elements in the project’'s CTR or PCN drawing. This not only creates the contours,
but also text at the appropriate scale of the drawing.
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A terrain’s level display can work to turn levels on and off, but it depends what the “feature” definition of the actual terrain model is
set to and how it is manipulated in its own dgn file. All the properties of a terrain model could be turned on in the terrain’s dgn file
so everything is displayed. When that terrain dgn is referenced to another drawing, all of those things will be displayed. Levels
not needed for the display could be turned off and then back on if needed. However, it takes time and the computer’'s memory to
have all that info displayed all the time and then the levels shut off. If the “default” state is to only have the Terrain Boundary turned
on, it can easily be adjusted to turn on what is needed without taking up the memory of having everything in the background. This
is particularly significant on larger projects with thousands of contour lines or a terrain containing LiDAR data.

Environmental Drawings

To avoid confusion, Environmental data should be on a single drawing. If placed on the Default model of the ORD drawing 12345-
E-Env.dgn, then elevations can be attached from the terrain model so the features will appear on cross sections.

If a 12345env file exists in the Prj folder, it should contain a note like the one shown here alerting people that the Environmental
data is contained in the ORD drawing.

ENVIRONMENTAL INFORMATION FOR THIS PROJECT IS IN THE
N:\CADD\PBT\yourtown\12345\Cadd\OpenRoads\FinalDesign\12345-E-ENV.dgn

Zoom into the text and save settings so this note appears prominently when the drawing is opened. if the text is as big as the
project, anyone attaching the drawing as a reference file will also see it and know to detach it and attach the correct one.

Even though the drawing is in ORD, it can still be edited with MicroStation Connect. Limit MicroStation work to the Default model
which is 2D.

Right-of-Way Drawings

Ideally, the same could be done for the right-of-way lines. However, that needs to be coordinated with the Bureau of Right-of-
Way.

The ert drawing should remain a prj\12345ert.dgn and opened with MSC.

Cross-Section Notes

A cross section is a live look at the 3D model. It shows information that is directly cut across in the section’s Named Boundary.
As information is updated, the section’s graphics are automatically updated. The survey’s points drawing and other detail drawings
containing flat point features not turned on for the cross sections as these detail features are represented in the XS Detail drawing
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as generated tick marks. Just like before. The Drainage and Utilities drawing’s 3D models represent actual 3D model of the

features used for section representation.

Note that annotation which has been added does not automatically update. Groups of annotation exist such that you remove it
from all the models and then re-annotate it as a group. This covers all the superelevation labels, slope labels, the top lines points
offset and elevation, the existing feature labels such as the EP, TW, delineated wetlands, cells for ROW, Guardrail cells, XS Detall

cells such as trees and poles.

When a set of sections are cut, it creates the drawing models (where labels are added) and sheet models (which reference the
drawing models into sheets). If additional sections are cut at a later time that need to be sheeted ORD version 2021-R1/2 has a
way of updating the sheets without losing the manually added data. This is an enhancement that we and other DOT’s requested.
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User Files and Settings

Settings

For MSC and ORD the user’s files will now be saved solely in the C drive locations as defined by Bentley. We had previously
stored them on the N drive so that they would be portable to conference rooms and other locations but this was causing corruptions.
To update your user preference files run (Double Click on) the batch files N:\CADD\Misc Accounts\Cadd\Connect-users\Copy-
msc-Seed-to-C.bat and Copy-ord-Seed-to-C.bat. These will update your C drive profiles.

The Seed settings contain the NHDOT’s default settings. They can be checked by accessing the preferences through File >
Settings > User > Preferences. Review the entries and compare them to the highlighted entries in ORD & MS preference file
settings - NHDOT_Seed_upf CONNECT.docx or those shown below.

Category Option Setting
Input ESC exits command (ON) [NHDOT SETTING]
Hold Delay 20 [NHDOT SETTING]
Mouse Wheel Wheel: Zoom In/Out [DEFAULT] or
Pan With Zoom [NHDOT SETTING]
Operation Highlight Broken Associations (OFF) [NHDOT SETTING]

Raster Manager - General

Disable Delete Element

(ON) [NHDOT Setting]

Raster Manager - Default Attributes

Set Defaults — Geometry — Inherit GeoCS from

Model:

Inherited [DEFAULT]

Raster Manager - Georeference

Use Sister Georeferenced File

(ON) [NHDOT Setting]

Save Location Information

(ON) [NHDOT Setting]

Sister File: 1 Unit = 1.0000 [DEFAULT]

US Survey Feet [NHDOT Setting]

Raster file: 1 Unit = 1.0000 [DEFAULT]

US Survey Feet [NHDOT Setting]

Text

Hide Field Background

(ON) [NHDOT Setting]

View Options Civil - Drainage and
Utilities

Orient Top to Surface Max Slope

8.01% [NHDOT SETTING]

Profile Node Drawing

Slice [NHDOT SETTING]

View Options Civil - Manipulator
Settings

Manipulator Size

15 [NHDOT SETTING]

Normal Color

255,255,0 [NHDOT SETTING]
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User Files Corruptions and Back-up/Restore Batch files

Now that we are using the C drive locations for the user’s preference files, the N drive location will be used as the backup location.
By saving them on the network users can access them when working on computers in the conference rooms. When your setup is
working well backup your user preference files, run (Double Click on) the batch files N:\CADD\Misc Accounts\Cadd\Connect-
users\Copy-msc-C-to-N.bat and\or Copy-ord-C-to-N.bat. This will save a copy of your current user preferences to the N drive
location. The Back ups should be created after working with and setting up your workspaces as you want them.

e N:\CADD\\Misc Accounts\Cadd\Connect-users\ORD _Users\n34xxx
e N:\CADD\Misc Accounts\Cadd\Connect-users\MS_Users\n34xxx.

The settings files can become corrupt or changed if using different workspaces such as the Bentley Training and Examples the

setttings in the personal dgnlib can be changed from the NHDOT default settings listed in the section above. To Restore the
backed up preferences or to use them on a different computer run (Double Click on) the batch file’s N:\CADD\Misc

Accounts\Cadd\Connect-users\Copy-msc-N-to-C.bat and\or Copy-ord-N-to-C.bat.

Please report any problems or suggestions regarding the Seed preferences to the CADD Staff.
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CONNECT Edition Test Projects

ORD and MSC products SHOULD NOT BE USED TO OPEN YOUR SS4 PROJECT FILES!!! If you are testing these products,
you should be working in a copy of your project created by the CAD/D staff or in a training project on your C drive. Upon request
your project will be copied into a new 12345-1 project where you can use the new software to accomplish design tasks in parallel
with your SS4 project work. Before work can begin using MicroStation or ORD CONNECT Edition the survey detail will need to
be brought into the Terrain dgn as ORD features. SS4 OpenRoads features are not compatible with ORD so the survey needs to

be recreated for ORD.

Before working in CONNECT, contact the CAD/D staff so they can create the

ORD project and terrain drawings. It should be discussed who will update | ©bsolete Civil Data Found X
any existing drawings to use CONNECT levels, linestyles, fonts, and cells. It
is not an automated process and takes time. The Civil Data [V8i (SELECTSeries 4] found in this file is not
supported b_}.r OpenRoads De_signer Connect Edition.
Once you have a CONNECT project feel free to open any dgns with Would you like to open the file Read-Only?
Press Cancel to Close this file,

MicroStation CE. MicroStation drawings can be read from either CE or SS4
but if you create things using new CE functionality it will not work when
opening from SS4. SS4 civil drawings opened with ORD will produce the

Obsolete Civil Data note shown here.

SS4 projects use PCF files, CE projects use a CFG file. When opening either project make
sure you start the product and use the Project selector to set the project appropriately and
you will end up in the correct set of project directories! Do not open your SS4 files with CE
products even if you can, KEEP THEM SEPARATE!! If you don’t see your project in the list
you may not be configured correctly to use the NHDOT Workspace and Worksets. See the
CAD/D staff for assistance.

After installation of CE you may find that MicroStation CE is the default program to open
DGN files. Change it back to SS4 so if you double click on a file it opens SS4 by default. It
is better to never double click on a file to open it but sometimes it happens. To re-associate
SS4 MicroStation with dgn files, right click on a dgn and pick Open With > Choose Another
App > Select MicroStation SS4 and check the box indicating to Always use this app to
open .dgn files. If needed the path to SS4’s executable is C:\Program Files
(x86)\Bentley\MicroStation V8i (SELECTseries)\MicroStation\ustation.exe

How do you want to open this file?

Keep using this app

i{“‘f MicroStation V8i (SELECTseries 4)

&

Other options

MicroStation CONNECT Edition

@ OpenRoads Designer CONMECT Edition -
F 2019 Release 2

More apps
&/ Always use this app to open .dgn files

OK
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Project Configuration Files

Each project has a configuration file which contains variables that point to the projects directories as well as defining the projects
information that is annotated onto the plan sheets such as the Project Number and Town name. The files are located in
N:\CADD\CADD\NHDOT_ Workspace\Projects\ . PCF files are for v8i projects, CFG files are for ORD and MSC projects. If a
project has been converted from v8i to connect the PCF file is renamed to have -ss4 added to the name. The -1.CFG files are for

Test projects (as noted above) that will remain as v8i projects.

If a project is a proposal project a variable can be added to the pcf fle MS_SHTSIZE = B defining the size of the sheet models
when creating plans. The Options are D-22x34, B-11x17 and A-8.5x11. If the variable is not defined then the default sheet size
is D 22x34.

The configuration file also contains Reference file directory paths and should be updated when the Design changes from
Preliminary to Final. (MS_RFDIR > $(PROJDIR)OpenRoads/PreliminaryDesign/ update to /FinalDesign/)

Geographic Coordinate System
The Geographic Coordinate System (GCS) dialog is used to report, select or delete a GCS for the current model in the design file.

Find this dialog from the Drawing workflow, Utilities tab. Clicking the Coordinate System = putton will open the Geographic
Coordinate System dialog shown below.

" Geographic Coordinate System

e & & r e

.\Fa.:- " " ! E __;

-
Current Geographic Coordinate System
Mame: <Mone=

Description:

Source:

The NH83/2011F is the Default Geographic Coordinate System attached to NHDOT seed files.
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The GCS can be manually set for the current design file. From the Geographic
Coordinate System dialog, select the From Library button (the second button from
the left) to get the Select Geographic Coordinate System panel (shown to the right).

At this point there are two choices, the Library option and the Search option. Each

Search Text nh83

option is presented as a tab. Of the two choices, the Search option is easier. From i oo S
the Search tab, enter the partial GCS Name of NH83 in Search Text. This will present o I i -
H ; ; DEERREHRIE NAD83/2011 New Hampshire State Planes, US ... F
all of the matching New Hampshire State Plane options of GCS. S b s s S e e ™
NH83 NADS83 New Hampshire State Planes, Meter ]

Select the target GCS for this project from the Search Results and then click the Add
To Favorites button. This GCS may be used now and will be available in the future.
Return to the Library tab and select the target GCS which was just added and is now
available in the Favorites folder. Select OK to set.

NH83/2011  NAD83/2011 New Hampshre State Planes, Meter ¥

‘ Add To Favorites { Properties. ..

The following warning panel might appear.

The units of Geographic Coordinate System NHE3/2011F are US Survey Feet, but the
Storage Units in the model are Inches. Please review the units used in the source data
for this design.

@ The graphic elements are correctly drawn in Inches. The storage units should not be
changed.

Change the storage units in the model from Inches to US Survey Feet to match the
Geographic Coordinate System. The physical size of graphic elements will be changed.

Accept the default selection indicating that the elements are drawn correctly.

In order to set/check the Vertical Datum, select the Details... tool (first button) of the Geographic Coordinate System dialog box.
The Geographic Coordinate System Properties panel of the currently set GCS will appear. At the bottom is a section for Coordinate
System Modifiers. Confirm that the Vertical Datum is correct or change if necessary. Click OK when finished.
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Help and Training
Introduction

Before You Begin

Bentley Help can be accessed by clicking on File > Help. In the
Help screen click on Help Contents, CONNECT Advisor, Bentley
Institute, and OpenRoads Communities links are below it and can
also be used to find online help, community posts, videos and
documentation.

Off/Online Help

Bentley Help will show the ORD online help page with Readme
file link at the bottom. The help shows all the various ribbon
workflows and the tools available under each. Use this to
become familiar with what each tool does and how to use them.

In the readme contents there is a page OpenX DesignerTraining
which contains links to the Bentley Learn Server Learning Paths.
There are several Quick Start Guides to choose from.

Bentley Communities Training Links

The following links are to the Bentley Communities site for Road
and site design and contains a lot of useful information.

B <« [E ribboninte =5 Viewleam & Bentley Inst # OpenRoa

= O o https://docs.bentley.com/Liv
Weather in Louden - Loudon, NH Interacti Roadway Designer - ¢ LA AreaAnnotator™ < Find Training
=1 OpenRoads Designer CONNECT Edltu Search
T= Home - /8
4
OpenRoads Designer CONNECT
(] -
N Edition Help
» Last updated: February 03, 2020
b File
P Home
b Terrain
P Geometry
P site Layout
»
P Model Detailing File
» Home
P Survey Terrain
[ Microstation G_enmetry
Site Layout
[ Descartes
0 Model Detailing
[ Geotechnical
» Survey
MicroStation

Contents
Index

- N G- o technical

Descartes

Tool Index

Key-in Index

https://communities.bentley.com/products/road site design/w/road and site design wiki/33436/openroads-designer-

connect-edition-training-links

https://communities.bentley.com/products/road site design/w/road and site design wiki/33435/openroads-designer
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Training Options

There are a variety of resources available for learning MicroStation and OpenRoads Designer. Each registered Bentley user has
access to their LearnServer which contains many short videos and full classes with videos and workbooks. There are also
YouTube channels with playlists of videos to demonstrate the products. NHDOT has also developed some videos to describe our

processes.
These and other resources can be found by clicking the link at the bottom of the CAD/D homepage or going directly to:

https://nhgov.sharepoint.com/sites/DOT-ProjectCentral-Home/SitePages/CADD-Training.aspx
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